Contents

Chapter 1 △ Introduction to the SAS Add-In for Microsoft Office  △ 1
What Is the SAS Add-In for Microsoft Office?  △ 1
Benefits to Using the SAS Add-In for Microsoft Office  △ 1
How to Use the SAS Add-In for Microsoft Office  △ 2
Accessibility Features of the SAS Add-In for Microsoft Office  △ 3

Chapter 2 △ Learning by Example: Analyzing and Reporting Using SAS  △ 5
About the Scenario in This Book  △ 5
Prerequisites for This Scenario  △ 6
How to Get Help for the SAS Add-In for Microsoft Office  △ 6

Chapter 3 △ Opening a SAS Data Source in Microsoft Excel  △ 7
About the Tasks That You Will Perform  △ 7
Open the Sales Data in an Excel Worksheet  △ 7
Save the Workbook  △ 10

Chapter 4 △ Running SAS Tasks to Analyze the Data  △ 11
About the Tasks That You Will Perform  △ 11
Compare Sales for Each Product  △ 11
Determine Average Sales, Inventory, and Returns for Each Product  △ 16
Determine Correlation between Sales, Inventory, and Returns  △ 21
Perform a Linear Regression Analysis  △ 26
Save the Workbook  △ 31

Chapter 5 △ Analyzing a SAS Data Source in a PivotTable Report  △ 33
About the Tasks That You Will Perform  △ 33
Open the Sales Data into a PivotTable Report  △ 33
Create a PivotTable Report for the Sport Shoe Product Line  △ 36
Drilling Down on the Data for Asia in the PivotTable Report  △ 38
Save the Workbook  △ 40

Chapter 6 △ Next Steps: A Quick Look at Additional Features  △ 41
Working with Published Documents  △ 41
Working with Favorites  △ 44
Sending Results to Microsoft Word or Microsoft PowerPoint  △ 45

Chapter 7 △ Recommended Reading  △ 49
Recommended Reading  △ 49

Glossary  △ 51
Index  △ 53
What Is the SAS Add-In for Microsoft Office?

The SAS Add-In for Microsoft Office extends the functionality of Microsoft Excel, Microsoft Word, and Microsoft PowerPoint by enabling you to access SAS analytics and SAS reporting functionality without any SAS programming experience. The SAS add-in is designed for users who are familiar with these Microsoft Office programs but who might be new to SAS.

The SAS add-in includes approximately 80 SAS tasks that enable you to perform a variety of analyses. Examples of analyses that you can perform include linear and nonlinear regressions, multivariate analyses, time series analyses, one-way frequencies, and summary statistics. The SAS add-in enables you to refresh these analyses so that your results include the most up-to-date information. You can also easily share the results with others at your site.

When the SAS add-in is installed on your computer, a SAS tab is automatically integrated into the Ribbon in Excel, Word, and PowerPoint 2007. The SAS tab enables you to access the SAS analytics and reporting functionality directly from these Microsoft Office programs without having to open a separate SAS interface.

*Note:* If you are using Microsoft Office 2000-2003, then a SAS menu is automatically integrated into Excel, Word, and PowerPoint. You can perform the tasks in this book if you are using Microsoft Office 2000-2003. However, the SAS options are located in the SAS menu rather than the SAS tab. The instructions and screenshots in this book are specific to Microsoft Office 2007. △

Benefits to Using the SAS Add-In for Microsoft Office

Most of the SAS add-in functionality is identical in Excel, Word, and PowerPoint; for example, you can run analyses and reports in all three applications.

The SAS add-in extends the functionality in Excel, Word, and PowerPoint by enabling you to complete the following tasks:

- **Access SAS data sources as the input data for your analysis.** You can use any SAS data source or any data source available from your SAS server (including databases such as Oracle, Teradata, and DB2) as the input data for an analysis.
Perform more complex analyses and computations than what is available in Microsoft Excel. For example, one of the complex analyses that SAS provides is the Canonical Correlation task. This task enables you to examine the relationship between a linear combination of a set of X variables and a linear combination of a set of Y variables. You might run a canonical correlation analysis to determine the degree of correspondence between a set of job characteristics and a set of measures of employee satisfaction. This extends the correlation analysis that is available in Excel. You can run these complex analyses and computations in Excel, Word, or PowerPoint.

Run custom analyses that were developed by others at your company. Using the SAS add-in, you can also open reports that were developed by SAS Enterprise Guide or SAS Web Report Studio users at your site. Some of these reports might run programs called SAS Stored Processes. These programs are customized SAS code that is developed by business analysts or your IT department. Running these programs enables you to quickly generate a custom report without writing any SAS code.

Refresh the content in the Excel worksheet, Word document, or PowerPoint presentation on demand or automatically at a specified time. Scheduling when the content is refreshed enables you to have the most up-to-date data and reports when you need it.

Publish the results to a central location. By publishing a document, you can share it with others without having to e-mail it. If you publish the document to a metadata repository, then you can perform an impact analysis on the document. Impact analysis enables you to see where a data source came from and the items that are dependent on this source. This analysis enables you to know how changing a data source might affect other documents.

Additional functionality is available in Excel. In Microsoft Excel, you can also complete the following tasks:

Access and view data sources that exceed the 1,048,576 record limitation in Microsoft Excel 2007. (In Microsoft Excel 2000-2003, this record limit is 65,536.) The SAS add-in does its processing on the server, which enables it to by-pass the record limitation in Excel.

Copy data to a SAS server. You can copy an Excel data source or a SAS data source to the SAS server. After a data source is copied to a SAS server, it becomes a SAS data set. This enables you to share Excel data with Word and PowerPoint users at your site. This functionality also enables Excel users to update information in a SAS data source and upload it to the SAS server.

Send the results from an analysis that you ran in Excel to a Word document or PowerPoint presentation. For example, you ran an analysis of your company’s sales for this year, and now you need to give a presentation of the results. Using this functionality in Excel, you can select which results to include in a PowerPoint presentation. This saves you time because you need to run the analysis only once.

This book explores some of the basic tasks that you can perform in Excel.
You can perform a variety of tasks using the SAS add-in. The following process briefly explains how you would run a SAS analysis:

1. Open Microsoft Excel.
2. Select the analysis that you want to perform.
   
   Note: After you select the analysis, you might be prompted to log in to the SAS server if you have not previously logged in during the current session. You must be connected to a SAS server to run an analysis or to access a SAS data source.
3. Select the data source that you want to use in the analysis. In Excel, you can use data in an existing Excel worksheet or in a SAS data source. If you select a SAS data source, you can choose to filter and sort the data before the analysis.
   
   Note: If the SAS data source is open in an Excel worksheet, then the task uses the filter and sort criteria that you specified when opening the data source.
4. Select the options in the analysis that you want to use and then run the analysis.
5. Specify the location of the output. For example, in Excel you can choose to include the results in the existing worksheet, in a new worksheet, or in a new workbook.

The results automatically open in Excel in the location that you chose.

Note: The SAS add-in is also available in Microsoft Word and PowerPoint.

---

**Accessibility Features of the SAS Add-In for Microsoft Office**

The SAS Add-In for Microsoft Office includes accessibility and compatibility features that improve usability of the product for users with disabilities. These features are related to accessibility standards for electronic information technology adopted by the U.S. Government under Section 508 of the U.S. Rehabilitation Act of 1973, as amended. For more information about the accessibility of the SAS Add-In for Microsoft Office, see the online Help.

If you have questions or concerns about the accessibility of SAS products, send e-mail to accessibility@sas.com.
About the Scenario in This Book

This book is intended for Microsoft Excel 2007 users. Each topic in this book builds on the previous topic, so you must work through the chapters in sequence.

For the purpose of the scenario in this book, you are a data analyst for a company that sells men’s and women’s shoes worldwide. You have been asked to analyze the company’s global sales for 2008. The data is saved as a SAS data source. Your company recently purchased the SAS Add-In for Microsoft Office, so you can now access SAS data sources from Excel. You are an experienced Excel user, but are new to SAS.

The next three chapters provide step-by-step instructions for analyzing a data source and creating an Excel workbook that can be shared with others at your site. During the first part of the scenario, you will open the SAS data source that contains your company’s 2008 sales data into an Excel worksheet. Then you will run four SAS tasks to analyze the data. Running these SAS tasks will enable you to answer the following questions:

- Which product had the highest sales in 2008? Which product had the lowest sales?
- What are the average total sales, average total inventory, and average returns for each product?
- Is there a correlation between the total sales and inventory and returns for each product?
- Which parameters (inventory, returns, and number of stores) determine the total sales for a product?

After answering these questions, you are asked to analyze the sales for the product line with the lowest sales. During this second part of the scenario, you will open the SAS data source into a PivotTable report to answer the following questions:

- Which regions have sales less than $10,000?
- Which region has the lowest sales? What are the sales and inventory costs for each subsidiary in that region?

By the end of this scenario, you will have an Excel worksheet that you can publish to a common repository, so it can be viewed by other SAS add-in users at your site.
Prerequisites for This Scenario

By the time that you are ready to perform the tasks in this book, administrators at your site should have installed and configured all necessary components of the SAS Enterprise Intelligence Platform. You must also have the following set up:

- Microsoft Office 2007 installed on your desktop.
- Permissions to access the SAS Metadata Server. SAS support personnel at your site set these permissions. Contact SAS support personnel at your site for the name and location of the SAS Metadata Server.
- A metadata configuration file to specify which SAS Metadata Server you will connect to by default. This file enables you to access SAS data sources on remote servers. For more information about setting up a metadata configuration file, see the online Help for the SAS add-in.
- Access to the SHOES data source that is available in the SASHELP library. This is the data source that you will be using during the analysis. The SASHELP library ships with the SAS Add-In for Microsoft Office. If you do not have access to this SAS library, contact the SAS support personnel at your site.

How to Get Help for the SAS Add-In for Microsoft Office

Use any of the following methods to get Help for the SAS Add-In for Microsoft Office:

- In the Ribbon, click the SAS tab. In the Manage group, click Help and select SAS Add-In for Microsoft Office Help.
- Press F1 in most application windows and dialog boxes.
CHAPTER 3
Opening a SAS Data Source in Microsoft Excel

About the Tasks That You Will Perform

To open and view the data that you will be using in the analysis, you will perform the following main tasks:

1. Select the data source to open.

   Note: In this scenario, you are accessing a SAS data source from the SAS server. However, you can use the SAS add-in to access data from a database, such as Oracle, Teradata, and DB2. In Excel, you can also use Excel worksheets as the data source.

2. For the data source, select the following:
   - the variables to include in the output
   - the sorting order for the data
   - the output location for the data

Open the Sales Data in an Excel Worksheet

To open the SHOES data source (which is available in the SASHELP library) in Excel, follow these steps:


   Microsoft Excel opens. In the Ribbon, you should see a SAS tab. You access the SAS add-in from this menu.

   Note: If you do not see a SAS tab, then you might not have the SAS add-in installed. For help, contact the SAS support personnel at your site.

Display 3.1   The SAS Tab in Microsoft Excel
2 In the Ribbon, select the **SAS** tab. In the **Data Options** group, click **Open Data** and select **Into Worksheet**. The Open Data Source window opens.

3 Click **Servers** to select the SAS server that you want to use. The Open Data Source window now displays the libraries on the selected server.

4 Select **SASHELP** and click **Open**. The Open Data Source window now displays the contents of the SASHELP library.

Note: The location of the SASHELP library is dependent on how SAS was installed at your site. If you cannot find the SASHELP library, contact the SAS support personnel at your site.

5 In the SASHELP library, select the **SHOES** data source and click **Open**. The Modify Data Source window opens.

6 On the **Variables** tab, select the variables that you want to include in the final output. You can also specify the order of the variables.
Click \( \rightarrow \) to move all the variables from the Available list box to the Selected list box. Select the variables so they appear in the following order:

\[
\begin{array}{ccc}
\text{Region} & \text{Product} & \text{Country} \\
\text{Order} & \text{Region} & \text{Week} \\
\text{Sales} & \text{Product} & \text{Inventory} \\
\text{Returns} & \text{Currency} & \text{Total Returns} \\
\end{array}
\]

Click the Sort tab and continue.

7 On the Sort tab, you can specify the order of the rows in the output.

Use the drop-down lists to specify the following sort order:

\[
\begin{array}{cc}
\text{Region} & \text{Order} \\
\text{Product} & \text{Week} \\
\end{array}
\]

Click the Output Location tab and continue.

8 On the Output Location tab, you can select the location for the final output.

By default, the data source is opened in a new worksheet. In the Named box, delete SASHELP.SHOES and type Worldwide Shoe Sales.

Click OK. The results open in a new worksheet called Worldwide Shoe Sales.
As you scroll through the data, you see the following:

- Ten regions are represented: Africa, Asia, Canada, Central America/Caribbean, Eastern Europe, Middle East, Pacific, South America, United States, and Western Europe.
- There are eight product types: Boot, Men’s Casual, Men’s Dress, Sandal, Slipper, Sport Shoe, Women’s Casual, and Women’s Dress.
- For each Region, the data is divided into product and subsidiary.
- For each subsidiary, the data contains the number of stores that sell each product, the total sales, total inventory, and total returns for the product.

### Save the Workbook

To save the workbook, follow these steps:

1. Click and select **Save As ➤ Excel Workbook**. The Save As dialog box opens.
2. From the **Save in** drop-down list, select `C: \ My Documents`.
3. Type **Shoe Sales 2008** in the **File name** box.
4. Click **Save** to save the workbook.

You are now ready to analyze the data source. For the next steps, see Chapter 4, “Running SAS Tasks to Analyze the Data,” on page 11.

*Tip:* After opening a data source in Excel, you do not have to save the workbook before analyzing the data.
CHAPTER 4

Running SAS Tasks to Analyze the Data

About the Tasks That You Will Perform

These tasks assume that you have the SHOES data source open in a Microsoft Excel worksheet. For these steps, see Chapter 3, “Opening a SAS Data Source in Microsoft Excel,” on page 7.

To analyze the data, you will perform the following main tasks:

1. Create a bar chart to compare the sales of each product and to determine which products have the highest and lowest sales.
2. Use summary statistics to determine the average total sales, average total inventory, and average returns for each product.
3. Determine whether there is any correlation between the total sales and total inventory and total returns for each product.
4. Use a linear regression to determine whether the parameter estimates for inventory, returns, and number of stores should be included in a linear regression model of sales.

Compare Sales for Each Product

To create a bar chart that shows the sales for each product, follow these steps:

1. From the Active Data drop-down list on the SAS tab in the Ribbon, verify that SASHELP.SHOES is the active data source that you opened in the previous chapter.

   Note: In the Active Data drop-down list, the name of the SAS server appears before the name of the data source. The name of the server depends on the SAS server at your site. △
Tip: In Excel, data sources that are open are at the top of the Active Data drop-down list and have an exclamation point (!) before the name. By default, the current selection is the active data source. Depending on where your cursor is in a worksheet, you might have a different active data source.

2 In the Analyze Data & Report group, click Graphs and select Bar Chart Wizard. The Bar Chart Wizard opens.

3 In step 1 of the wizard, you can verify that you have selected the data source that you want to use.

   Tip: You cannot change the data source after you open a SAS task. However, you can apply a filter by clicking Edit.

   For this example, you should have the SHOES data source as the active data. Click Next to continue.

4 In step 2 of the wizard, you can assign variables from the data to roles. You can also specify whether to create a horizontal bar chart. By default, the Bar Chart Wizard creates vertical bar charts.

   In the second step, specify the following options:
   □ From the Bars drop-down list, select Product.
   □ From the Bar height drop-down list, select Total Sales.
Click **Next** to continue.

5 In step 3 of the wizard, you can specify the appearance of the chart.

In the third step, select the **Data labels** check box, and then select **Sum** from the drop-down list.
Click **Next** to continue.

6 In step 4 of the wizard, you can customize the title and footnote for the chart. The Bar Chart Wizard provides a default title and footnote.

In the Graph box, delete **Bar Chart**, and type **Total Sales for Each Product**.
Click **Finish**. The Choose Location dialog box opens.

From the Choose Location dialog box, select **New worksheet** and in the **Named** box, type **Total Sales for Each Product**.

Click **OK**. The results open in a new worksheet called **Total Sales for Each Product**.
The bar chart shows the following:

- Men’s Casual shoes had the highest sales with $7,933,707.
- Sport Shoes had the lowest sales with $651,467.

## Determine Average Sales, Inventory, and Returns for Each Product

To create an analysis that shows the average sales, inventory, and returns for each product, follow these steps:

1. From the **Active Data** drop-down list on the **SAS** tab in the Ribbon, verify that **SASHELP.SHOES** is the active data source.

   ![Active Data](image)

2. In the **Analyze Data & Report** group, click **Describe** and select **Summary Statistics Wizard**. The Summary Statistics Wizard opens.

3. In step 1 of the wizard, you can verify that you have selected the data source that you want to use.

   **Tip:** You cannot change the data source after you have opened a SAS task. However, you can apply a filter by clicking **Edit**.

   For this example, you should have the **SHOES** data source as the active data. Click **Next** to continue.
4 In step 2 of the wizard, you can assign variables from the data to roles.

Select the following variables in the **Available variables** pane and drag and drop them to the following roles:

<table>
<thead>
<tr>
<th>Variables</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Sales, Total Inventory, Total Returns</td>
<td>Summary statistics of (Analysis variable)</td>
</tr>
<tr>
<td>Product</td>
<td>For each value of (Classification variable)</td>
</tr>
</tbody>
</table>
Click **Next** to continue.

In step 3 of the wizard, you can specify the statistics and the results to include in the output. By default, the Summary Statistics Wizard calculates the mean, standard deviation, minimum, maximum, and number of observations for each classification variable. However, you want to include the range of values and remove the number of observations from the output.

To specify the statistics to include in the output, follow these steps:

a. Click **Edit**. The Edit Statistics dialog box opens.

b. On the **Basic** tab, select the **Range** check box, and clear the **Number of observations** check box.
c Click **OK** to return to step 3 of the Summary Statistics Wizard.

The statistics that are listed in the Summary Statistics Wizard should now be as shown:

![Summary Statistics Wizard](image)

Click **Next** to continue.

6 In step 4 of the wizard, you can customize the title and footnote for the output.

In the **Analysis** box, delete **Summary Statistics Results** and type **Summary Statistics for Each Product**.
Click **Finish**. The Choose Location dialog box opens.

7 In the Choose Location dialog box, select **New worksheet**, and in the **Named** box, type **Summary Statistics**. Click **OK**.

The results open in a new worksheet called Summary Statistics.
Running SAS Tasks to Analyze the Data

Determine Correlation between Sales, Inventory, and Returns

The output shows the mean, standard deviation, minimum value, maximum value and range of the total sales, total inventory, and total returns for each product. An analysis shows the following aspects of the data:

- For each product, the average total cost of the inventory exceeds the average total sales. For example, for Boots, the average total inventory is $187,012.90, but the average total sales is only $45,202.75.
- The ranges for all products are rather large. For example, for Boots, the minimum total sales is $1,179 and the maximum total sales is $286,497. This large range ($285,318.00) implies that sales for boots vary across stores worldwide.

Determine Correlation between Sales, Inventory, and Returns

In the previous analysis, you saw that total inventory exceed sales for all products. Therefore, you want to analyze whether there is any correlation between total inventory and sales. You also decide to analyze the correlation between total returns and sales.

To determine whether there is a correlation between these items, follow these steps:

1. From the Active Data drop-down list on the SAS tab in the Ribbon, verify that SASHELP.SHOES is the active data source.

2. In the Analyze Data & Report group, click Analyze Data. The Analyze Data window opens.
In the left pane, select **Multivariate**. The list of tasks in this category appears in the right pane.

4 Select **Correlations** and click **Open**. The Correlations task opens.

5 In the Data panel, you can assign variables from the data source to task roles. Select the following variables in the **Variables to assign** pane and drag and drop them to the following roles:

<table>
<thead>
<tr>
<th>Variables</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Sales</td>
<td>Analysis variable</td>
</tr>
<tr>
<td>Total Inventory, Total Returns</td>
<td>Correlate with</td>
</tr>
</tbody>
</table>
In the selection pane, select **Results** and continue.

6 In the Results panel, you can specify whether to include any plots in the output and what statistics to include in the output. You can also view a summary of the correlations for the task.

For this analysis, select the **Create a scatter plot for each correlation pair** check box.
In the selection pane, select **Titles** and continue.

7 In the Titles panel, you can customize the title and footnote for the output.

To create a custom title for the analysis, follow these steps:

a In the Section area, select **Analysis Titles**.

b In the **Text for section: Analysis Titles** area, clear the **Use default text** check box.

c Delete the default text and type **Correlation of Sales to Inventory and Returns**.
Click **Run**. The Choose Location dialog box opens.

8 In the Choose Location dialog box, select **New worksheet**, and click **OK**.

The results open in a new worksheet called **Correlations**.
The output shows the correlation statistics for the correlation between sales and inventory and sales and returns. An analysis shows the following aspects of the data:

- The correlation between sales and inventory is 0.95444. This implies a strong positive correlation between sales and inventory.
- The correlation between sales and returns is 0.96434. This implies a strong positive correlation between sales and returns.
- The scatter plots also reflect this strong positive correlation. The scatter plots also show that the data contains a few possible outliers.

**Perform a Linear Regression Analysis**

In the previous analysis, you saw that total inventory and returns were strongly correlated to sales. You now want to perform a linear regression analysis on the data. You want to determine what model you can use to determine total sales for each product.

To run a linear regression analysis, follow these steps:

1. From the **Active Data** drop-down list on the **SAS** tab in the Ribbon, verify that SASHELP.SHOES is the active data source.

2. In the **Analyze Data & Report** group, click **Analyze Data**. The Analyze Data window opens.

3. In the left pane, select **Regression**. The list of tasks in this category appears in the right pane.
4 Select **Linear Regression** and click **Open**. The Linear Regression task opens.

5 In the Data panel, you can assign variables from the data source to task roles.

Select the following variables in the **Variables to assign** pane and drag and drop them to the following roles:

<table>
<thead>
<tr>
<th>Variables</th>
<th>Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Sales</td>
<td>Dependent variable</td>
</tr>
<tr>
<td>Total Inventory, Total</td>
<td>Explanatory variables</td>
</tr>
<tr>
<td>Returns</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td>Group analysis by</td>
</tr>
</tbody>
</table>

In the selection pane, select **Titles** and continue.

6 In the Titles panel, you can customize the title and footnote for the output.

To create a custom title for the analysis, follow these steps:

a In the Section area, select **Linear Regression**.

b In the **Text for section**: **Linear Regression** area, clear the **Use default text** check box.

c Delete the default text and type **Linear Regression Results for Each Product**.
Click Run. The Choose Location dialog box opens.

7 In the Choose Location dialog box, select **New worksheet** and click OK.

The results open in a new worksheet called Linear Regression.
Before running this analysis, you assumed a significance level of 0.05. Therefore, any parameter estimates that have a $p$-value less than 0.05 should be included in the model. Any parameter estimates that have a $p$-value greater than 0.05 should not be included in the model.

The following analysis of the Boot product shows you how to analyze the results for each product.

- You can use the Pr>|t| column in the Parameter Estimates table to determine whether an input is statistically significant and should be included in the model.

  The total inventory and total returns have a $p$-value less than 0.05, so these inputs can be included in the model.
After you have determined that an input is statistically significant, you can use the value in the Parameter Estimate column to determine the impact that these inputs have.

The impact that each of these inputs have on total sales is as follows:

- For each $1.00 spent on inventory, total sales increase by $0.10.
- For each $1.00 of returns, total sales increase by $17.07. While at first this result was confusing, you remembered that some of your stores charge a 20% re-stocking fee on all returns. This means that your company still makes some money off of returned items.
You can perform the same analysis on the other products.

---

Save the Workbook

To save the workbook, click in the Quick Access Toolbar.

You have now finished your initial analysis of your company’s 2008 sales data. You can now use a PivotTable report to analyze a specific product line. For more information, see Chapter 5, “Analyzing a SAS Data Source in a PivotTable Report,” on page 33.
About the Tasks That You Will Perform

During the first part of the scenario, you saw that sports shoes had the lowest sales. After your initial report, your managers asked you to identify the regions that had sport shoe sales less than $10,000, and to perform a more in-depth analysis into the region with the lowest sales. Because you are in Microsoft Excel, you can perform this analysis using a PivotTable report.

To analyze the Sport Shoe product line, you will perform the following main tasks:

1. Select the data source to open.
   
   Note: In this scenario, you are accessing a SAS data source from the SAS server. However, you can use the SAS add-in to access data from a database, such as Oracle, Teradata, and DB2. In Excel, you can also use Excel worksheets as the data source.

2. For the data source, select the following:
   - the variables to include in the output
   - a filter to subset the data
   - the output location for the PivotTable report

Open the Sales Data into a PivotTable Report

To open the SHOES data source (which is available from the SASHELP library) into a PivotTable report, follow these steps:

1. In the Ribbon, select the SAS tab. In the Data Options group, click Open Data and select Into PivotTable. The Open into PivotTable window opens.

2. Click to select the SAS server that you want to use. The Open Data Source window now displays the libraries on the selected server.

3. Select SASHELP and click Open. The Open Data Source window now displays the contents of the SASHELP library.
34 Open the Sales Data into a PivotTable Report

Chapter 5

Note: The location of the SASHELP library is dependent on how SAS was installed at your site. If you cannot find the SASHELP library, contact the SAS support personnel at your site.

4 In the SASHELP library, select the SHOES data source, and click Open. The Modify Data Source window opens.

5 On the Variables tab, you select the variables that you want to include in the final output. You can also specify the order of the variables.

   Click to move all the variables from the Available list box to the Selected list box. Select the variables so they appear in the following order:

   Click the Filter tab and continue.

6 On the Filter tab, you can specify the condition that you want to use to subset the data. On this tab, you will specify two conditions and join them by an AND operator to create a filter.
Use the drop-down lists and the text box to create the following filter:

![Filter description]

Click the Output Location tab and continue.

7 On the Output Location tab, you can select the location for the final output.

By default, the SAS add-in opens the PivotTable report in a new worksheet. In the Named box, delete SASHELP.SHOES and type Sport Shoe Sales Less Than 10,000.

![Output Location tab]

Click OK. The PivotTable report opens in a new worksheet called Sport Shoe Sales Less Than 10,000.
Create a PivotTable Report for the Sport Shoe Product Line

To create a PivotTable report that analyzes the actual and predicted sales for the Sport Shoe product line, follow these steps:

1. From the PivotTable Field List, drag and drop **Region** to the area marked **Drop Row Fields Here**.
2. From the PivotTable Field List, drag and drop **Product** to the area marked **Drop Column Fields Here**.

3. From the PivotTable Field List, drag and drop **Total Sales** in the area marked **Drop Data Items Here**.
The results show that three regions (Asia, Middle East, and Central America/Caribbean) have total sport shoe sales under $10,000. Asia has the lowest sales, so you want to drill-down on the data in the Asia region to investigate further.

### Drilling Down on the Data for Asia in the PivotTable Report

To drill-down on the data for the Asia region, follow these steps:

1. In the Region column, right-click in the Asia cell. From the pop-up menu, select **Expand/Collapse ✷ Expand**. The Show Detail dialog box opens.
2. Select **Subsidiary** and click **OK**.

The Asia row now shows the sales for the Seoul and Tokyo subsidiaries.
3. In the Subsidiary column, right-click on the Seoul cell. From the pop-up menu, select Expand/Collapse ➤ Expand. The Show Detail dialog box opens.

4. Select Total Inventory and click OK.

5. Right-click on the Tokyo cell. From the pop-up menu, select Expand/Collapse ➤ Expand.

   The Tokyo row now shows the inventory cost for the Tokyo subsidiary.
The results suggest the following:

- While the sales for the Seoul subsidiary were $937, the cost of inventory was only $455. This suggests that the profit for sport shoes was good. It could also suggest that demand for sport shoes exceeded the inventory that the Seoul subsidiary had in the warehouse.

- While the sport shoe sales for the Tokyo subsidiary were $1,155, the cost of inventory was $15,602. This suggests that the Tokyo subsidiary was not profitable in selling sport shoes. Then you remember that a low-price competitor recently entered the Tokyo market. The demand for sport shoes declined unexpectedly, and consequently, the Tokyo subsidiary has leftover inventory in the warehouse.

Before ordering sport shoes for either of these subsidiaries, your company will probably want to perform an in-depth market analysis into the trends in each of these markets.

---

**Save the Workbook**

To save the workbook, click in the Quick Access Toolbar.

You have now finished analyzing the sports shoe sales in a PivotTable report. This completes the second part of the scenario.
Next Steps: A Quick Look at Additional Features

What Is a Published Document?

After you have completed an analysis, you might want to share the results with others at your site. Published documents are Excel, Word, or PowerPoint documents that are saved to a common repository.

Publishing your documents to a common repository has the following benefits:

- The workbooks, documents, and presentations in this repository can be opened by others at your site.

- When you publish the workbook, document, or presentation to the metadata repository, information about all the data sources is saved to the repository. Storing this metadata in the repository enables you to perform an impact analysis on a document. Impact analysis enables you to see where a data source came from and the items that depend on this source. This analysis enables you to know how changing a data source might affect other documents.

Note: To publish a document, the SAS support personnel at your site must have installed SAS Web Report Studio on the same metadata server. If you cannot publish documents, contact the SAS support personnel at your site.
Publish the Sales Workbook

To publish the Shoe Sales 2008 workbook, follow these steps:

1. In the Ribbon, select the SAS tab. In the Manage group, click Tools and select Publish.

   Note: If you have any data sources that cannot be tracked in your document, then the Verify Document for Impact Analysis dialog box opens. Click OK to continue.

   The Publish window opens.

2. Select the location where you want to publish your document and click Save. The Properties dialog box for the published document opens.

   For more information about how to set the security settings for a document or folder, click Help in this window.
4 Click **OK** to publish the document.

---

**Open the Published Workbook**

After a document has been published to a metadata repository, others at your site can view this document.

For example, to open the Shoe Sales 2008 workbook, follow these steps:

1. In the Ribbon, select the **SAS** tab. In the **Analyze Data & Report** group, click **Reports**. The Reports window opens.
2. In the location where this report is saved, select **Shoe Sales 2008.xlsx**.
3. Click **Open**.

The document opens in Microsoft Excel.
Working with Favorites

What Is a Favorite?

Favorites in the SAS add-in enable you to quickly access your most commonly used reports and analyses. You can add published documents, reports, SAS tasks, and stored processes to your list of favorites.

Add a Favorite for the Shoe Sales 2008 Workbook

If you want to analyze the data in the Shoe Sales 2008 workbook frequently, you might want to add this published document to your list of favorites. To add the Shoe Sales 2008 workbook to your list of favorites, follow these steps:

1. In the Ribbon, select the SAS tab. In the Analyze Data & Report group, click Reports. The Reports window opens.

2. Right-click the Shoe Sales 2008.xlsx workbook and select Add to Favorites.

The Add to SAS Favorites window opens.

3. Select the folder where you want to save this workbook and click OK.
Run the Favorite for the Shoe Sales 2008 Workbook

To open the Shoe Sales 2008 workbook that you added to your list of favorites, follow these steps:

1. In the Analyze Data & Report group, click SAS Favorites.

The Shoe Sales 2008 workbook opens in Excel.

Sending Results to Microsoft Word or Microsoft PowerPoint

About Sending Results from Excel

After you performed your initial analysis of the company’s 2008 sales data in Excel, your managers asked you to create a short presentation for the yearly sales meeting. This presentation should include the following data:

- the total sales for each product
- the average sales, inventory, and returns for each product

From Excel, you can select the results from the Shoe Sales 2008 workbook to send to Word or to PowerPoint. When you select the SAS content to send, the current results for that analysis are automatically displayed in Word or PowerPoint. To make sure that the most up-to-date results are displayed in Word or PowerPoint, you should refresh the analysis after the results are sent to these applications.

Note: You can send only SAS content from Excel to Word or PowerPoint. Any formatting or text changes that you made to the SAS content are not sent. Only the results are re-opened in Word or PowerPoint.

You cannot send a SAS data source or data in an Excel worksheet. Word and PowerPoint are unable to open and read an Excel data source. Additionally, you cannot send a PivotTable report to Word or PowerPoint.
Send Results from the Sales Workbook to Microsoft PowerPoint

To send SAS content from the Shoe Sales 2008 workbook to Microsoft PowerPoint, follow these steps:

1. In the Ribbon, select the SAS tab. In the Manage group, click Tools, and select Send To Microsoft PowerPoint. The Send to Microsoft PowerPoint window opens and displays all the analyses in the Shoe Sales 2008 workbook.

   Tip: The SAS Content box lists the analyses in a workbook or worksheet. You can select a different workbook or worksheet from the View drop-down list.

   For each analysis, you can see the estimated time it will take to send each analysis to Word or PowerPoint. By default, all of the analyses are sent to Word or PowerPoint.

2. In the SAS Content box, clear the Correlations and Linear Regression check boxes.

   A Send to Microsoft PowerPoint window should appear that is similar to the following:

   Tip: You can change the order of the results by clicking or . The order of the results in this dialog box is the order that the results will appear in Word or PowerPoint.

3. Click Send.

   The current results automatically open in PowerPoint. You can now use the functionality in PowerPoint to customize these slides and create your presentation.
Refresh Your Results in Word or PowerPoint

To make sure that the most up-to-date results are displayed in Word or PowerPoint, you should refresh the analysis after the results are opened in Word or PowerPoint. You also might want to refresh your results if the data source for the analysis has been updated or modified since you last opened the results.

To refresh your results in PowerPoint, follow these steps:

1. In the Ribbon, click the SAS tab. In the Current Selection group, click Refresh and select Refresh Multiple. The Refresh Multiple Window Opens.
2 Click **Refresh**.

The SAS add-in refreshes all of the analyses in your presentation.

*Tip:* You can also use the Refresh Multiple window to select which analysis to refresh. For each analysis, the estimated time to run this analysis and the slide number of this content is listed. By default, all of the analyses are refreshed.
Recommended Reading

Here is the recommended reading list for this title:

- the online Help for the SAS Add-In 4.2 for Microsoft Office
- SAS offers instructor-led training and self-paced e-learning courses to help you get started with the SAS add-in, learn how the SAS add-in works with the other products in the SAS Enterprise Intelligence Platform, and learn how to run stored processes in the SAS add-in. For more information about the courses available, see support.sas.com/training.

For a complete list of SAS publications, go to support.sas.com/bookstore. If you have questions about which titles you need, please contact a SAS Publishing Sales Representative at:

SAS Publishing Sales
SAS Campus Drive
Cary, NC 27513
Telephone: 1-800-727-3228
Fax: 1-919-531-9439
E-mail: sasbook@sas.com
Web address: support.sas.com/bookstore

Customers outside the United States and Canada, please contact your local SAS office for assistance.
active data source

an Excel data source or a SAS data source that you specify to run all tasks on. Specifying an active data source enables you to perform multiple analyses on the same data source without having to specify that data source each time you run a task. See also SAS data source and task.

analysis

a statistical calculation that is generated by either a task or a stored process. See also task and stored process.

default metadata server

the metadata server that you are automatically connected to when you start Microsoft Word, Microsoft Excel, or Microsoft PowerPoint. See also metadata and metadata server.

default server

the SAS server that is automatically used to execute any tasks that use a Microsoft Excel worksheet or local data as the data source, unless an active data source that exists on a different server has been specified. See also active data source.

execution server

the server where the data is refreshed or the analysis is run.

favorite

in the SAS Add-In for Microsoft Office, a report, SAS task, stored process, or published document that you can quickly access.

filter

a program or section of a program that processes or forwards only the subset of a data source that meets specific criteria.

impact analysis

a search that enables you to track data sources and stored processes to see where they are used. For example, you can use a tool like SAS Data Integration Studio to determine what Microsoft Office documents are using a particular data source. This helps you to understand what items will be impacted if you delete or rename that data source.

metadata

a description or definition of data or information.
**metadata configuration file**
A file that enables users to specify which SAS metadata server they want to connect to by default. The connection to the metadata server enables users to access and run stored processes and to access SAS data sources on remote computers.

**metadata repository**
A collection of related metadata objects, such as the metadata for a set of tables and columns that are maintained by an application.

**metadata server**
A server that stores information about servers, users, and stored processes and that provides this information to one or more client applications.

**observation**
A row in a SAS data set. All of the data values in an observation are associated with a single entity such as a customer or a state. Each observation contains either one data value or a missing-value indicator for each variable.

**PivotTable**
An interactive table that analyzes and summarizes data in Microsoft Excel. You can rotate the rows and columns in the table to see different views of the data.

**published document**
A Microsoft Office document that is saved to a central repository. This workbook, document, or presentation can be opened with the appropriate Microsoft Office application.

**SAS data source**
A data file that contains SAS data. See also active data source.

**SAS library**
A collection of one or more files that are recognized by SAS and that are referenced and stored as a unit. Each file is a member of the library.

**stored process**
A SAS program that is stored on a server and which can be executed as requested by client applications. Stored processes are often used to create reports.

**task**
A program that generates and executes SAS programming code that performs a particular type of statistical analysis on the active data source that you have specified. A wizard prompts you for the information that is required in order to execute the task. See also analysis and active data source.

**variable**
A column in a SAS data set or in a SAS data view. The data values for each variable describe a single characteristic for all observations.
Index

A
accessibility features 6
active data sources 1
analyzing data 3, 5

B
bar charts 11

C
Choose Location dialog box 15, 20, 25, 28
correlation 21

D
data sources
accessing 11
copying 3
filtering 34
opening in an Excel worksheet 7
opening into PivotTable report 33
record limits 2
selecting variables for output 8
sorting output 9
specifying output location 9

F
favorites 43
adding 43
running 44

H
Help 6

I
impact analysis 41

L
linear regression 26

M
metadata configuration file 6
Microsoft Office 2000-2003 1
Modify Data Source window
Filter tab 2
Output Location tab 1
Sort tab 8
Variables tab 8

O
Open Data Source window 15

P
PivotTable reports
columns 37
creating 36
data items 37
drilling down to detail 38
rows 34
prerequisites 1
published documents benefits 41
impact analysis 41
opening 43
publishing 43

Q
Quick Access Toolbar 31, 40

R
Refresh Multiple Window 47
refreshing results 2, 47
in Microsoft PowerPoint 47

S
SAS Add-In for Microsoft Office benefits 1
online Help 1
SAS Enterprise Guide 3
SAS Enterprise Intelligence Platform
SAS menu 1
SAS Metadata Server 7
SAS Stored Processes 1
| SAS tab | 1, 5 |
| SAS tasks | 1, 5 |
| Bar Chart Wizard | 11 |
| Correlation task | 24 |
| Linear Regression task | 24 |
| Summary Statistics Wizard | 14 |
| SAS Web Report Studio | 3, 13 |
| SASHELP library | 2 |
| saving workbooks | 10, 31, 40 |
| scenario | 5 |
| sending results | 5, 45 |
| to Microsoft PowerPoint | 45 |
| SHOES data set | 6 |
| summary statistics | 44 |
Your Turn

We welcome your feedback.

☐ If you have comments about this book, please send them to yourturn@sas.com. Include the full title and page numbers (if applicable).

☐ If you have comments about the software, please send them to suggest@sas.com.